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Overview
Predictive Analytics 123 provides a forecast baseline based on historical data patterns. The

solution cycles through multiple statistical forecast methods based on seasonality and trend to

determine the most accurate forecast. It creates and presents models to support forecasting,

prediction, and what-if analysis to determine the most appropriate forecast scenario.

Some key points to know about Predictive Analytics are:

• No use of external variables for predictive enhancement

• Uses past target values (history) to produce future results. Example: Using the last 2 years of

monthly total sales values to produce estimates for each of the next 6 months.

NOTE: The more volatile the historical data the more likely the model is to produce
negative values in the forecast.

• Includes 12 base algorithms

• Each run has 10+ variations of models

• ARIMAmodels require 48 months of historical data

• Easy to interpret and understand

IMPORTANT: Predictive Analytics 123 is more effective when run on dense
historical data. If you have months in your historical data that are missing a value,

you should input a zero in that month.
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Getting Started
Use the following information to understand prerequisites and dependencies, plan your

installation, and configure the database server.

NOTE: Before beginning setup, verify that the SQL server has table creation rights
on the SQL database to create the custom tables.

Software Dependencies
This table describes external software dependencies:

Component Description

OneStream App for

Windows

Predictive Analytics 123 is optimized to run in the OneStream

App for Windows.

Select the Predictive Analytics 123
Development Location
Before installation, decide whether to build the solution directly in the Production OneStream

application or in a separate Development OneStream application. This section provides some key

considerations for each option.
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Production OneStream Application: The primary advantage of building the solution in a
Production application is that you will not have to migrate the resulting work from a Development

application. However, there are intrinsic risks when making design changes to an application used

in a Production capacity and it is not advised.

NOTE: OneStream strongly recommends that you implement the solution in the

Development environment with a fresh copy of the Production application before

starting work.

Development OneStream Application: As a best practice, use the Development OneStream
application to build the solution.

See Also: Modifying OneStream Solutions

Create the OneStream Development Application

1. Ensure that all the OneStream artifacts relating to Predictive Analytics 123 such as

Workflow Profiles and Entities are in the Production application.

2. Copy your Production OneStream application to your Development environment and

rename it. This Development version will be used for your Predictive Analytics 123 project.

Application Server Settings
IMPORTANT: OneStream cloud-based installations require users to log a support

ticket. Contact OneStream Support for assistance.
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You may need to edit the OneStream Application Server Configuration so users can create and

change data in the additional database tables. If other OneStream Solutions (such as Specialty

Planning) are already in the application, these adjustments may already exist.

Configure the OneStream Application Server

Be sure that the security group settings include the users who work on and set up the solution

before proceeding.

NOTE: Group settings are applicable to all OneStream Solutions; it is important to

keep the group names generic.

1. Start the OneStream Server Configuration Utility as an Administrator.

2. ClickOpen Application Server Configuration File > Database.

3. Edit the followingOneStream Database Server properties:

l Access Group for Ancillary Tables: Select a group that includes those who will access
records.

l Can Create Ancillary Tables: True

l Can Edit Ancillary Table Data: True

l Maintenance Group for Ancillary Tables: Select a group to edit and maintain tables.
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l Table Creation Group for Ancillary Tables: Select a group who can create tables.

4. Restart Internet Information Server.

Install Predictive Analytics 123
1. In the OneStream Solution Exchange, go toOneStream Solutions and select the

Predictive Analytics 123 tile.
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2. On the Predictive Analytics 123 Solution page, select your OneStream platform version

from theMinimum Platform Version dropdown list.

This selection displays the appropriate solution version in the next box.

3. Select the most recent version from the Solution Version drop-down list and click
Download.

4. Log in to OneStream.

5. On the Application tab, click Tools > Load/Extract.

6. On the Load tab, locate the solution package using the Select File icons and clickOpen.

7. When the solution’s file name appears, click Load.

8. Click Close to complete the installation.

Predictive Analytics 123 Setup
The first time you run Predictive Analytics 123, you are guided through the table setup process.

1. In OneStream, clickOnePlace > Dashboards > Predictive Analytics 123 > Predictive
Analytics 123.

Step 1: Setup Tables
This step may be necessary when upgrading even if tables are already present. Predictive

Analytics 123 will not drop any tables that already exist but will modify table structures and

add any new ones if necessary.

2. When setup is complete, click Step 2: Launch Solution to begin.
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Dashboard Maintenance Unit

XFW Predictive Analytics 123 (PAM)
The Dashboard Maintenance Unit provides the user interface for Predictive Analytics 123 and

includes the Dashboard Groups, Components, Data Adapters, Parameters, and Files used to

build the solution.

Business Rules

Business Rule Description

PAM_DataMgmt Extensibility Business Rule that manages the execution of the Run All

functionality.

PAM_
HelperQueries

Dashboard Dataset Business Rule that provides various data helper

functions for populating charts, grids, and BI Viewer components.

PAM_
ParamHelper

Dashboard XFBR String Business Rule that provides conditional

parameter processing functions that allow a parameter value to be

interpreted and substituted with a different string.
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Business Rule Description

PAM_
SolutionHelper

Dashboard Extender Business Rule that provides various helper

functions for Predictive Analytics 123 such as management of the

solution setup, configuration settings, and management of Predictive

Models.
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Settings
The Settings page contains the Global Options tab where you set key properties that guide
Predictive Analytics 123 administration. It also contains Uninstall options.

All global option settings are retained during solution upgrades.

Global Options
The Settings >Global Options page should be one of the first pages visited when configuring
Predictive Analytics 123.

NOTE: This file path will need to be obtained correctly from the Cloud team.
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Assign User Group to Security Roles

1. On the Settings page, clickGlobal Options and select the user group from the dropdown

list for each Security Role (the default value for all security roles is Administrators).

2. Click Save.

Security
Role

Description

Manage
Predictive
Analytics
Setup

Users in Predictive Analytics 123 are administrators who

can manage security settings in the Global Options page

and access the Setup page to create, edit, or delete

templates.

Execute
Predictive
Analysis
Models

Users can Run, Clear, and Delete models.

Predictive Analytics 123 Uninstall Options

Uninstall UI removes Predictive Analytics 123, including related dashboards and business
rules but leaves the database and related tables in place. Use this option to accept a Predictive

Analytics 123 update without removing the data tables. The Predictive Analytics 123 Release

Notes will indicate if an overinstall is supported.

Predictive Analytics 123 Guide xv

Table of Contents



For some releases, this step should be performed before accepting any new version of

Predictive Analytics 123 since some of the Dashboard or other objects may have been

renamed. Note that some Global Options will also be cleared as their values are stored in

Parameters under Dashboards.

Uninstall Full removes all the related data tables, all data, Predictive Analytics 123
Dashboards, and Business Rules. Use this option to completely remove Predictive Analytics

123 or to perform an upgrade with enough significant changes to the data tables that this

method is required.

CAUTION: The Uninstall procedure cannot be reversed.
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Home
The Home page contains Setup, Predict, and Audit.

Predictive Analytics 123 is grouped into three sections:

1. Setup establishes model templates that define the types of models to run, the data
sources, and determining the length of the forecast. It ties these parameters into a

designated Cube View through the template.

2. Predict displays the interactive mode that runs the models against a selected cell or all
accounts in a Cube View. Results are graphically displayed and written back to the target

scenario.

3. Audit provides auditability into the entire application by logging what is run, by whom, and
retains a comment log.
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Setup
The Template Setup page displays the Template Definition List which defines the Cube
where the data comes from, the Cube View against which you want to run models, and where

the results will be written.

Template Setup
The template sets up the use case scenario and can be modified in the Setup page until the ideal

build is calibrated. The Template Definition defines the prediction based on the cube view, target
scenario, and model functionality. This is the first step in the Predictive Analytics Machine

process.

The Template Setup page contains the following functions:

Add: creates a new template

Edit: updates an existing template

NOTE: Once a model is run, elements of the Cube View and Scenario sections

cannot be modified.

Copy: creates a new template based on the field-level parameters of the existing template

Delete: removes the entire template with the associated models and comments

Clear: removes the saved default models associated with the form, but keeps the results of
previously run models
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NOTE: The Delete function on the Template Setup page is different than the
Delete function on the Predict page.

Create a Template

IMPORTANT: There must be at least one template saved in order to run a model.

1. On the Template Setup page, click Add.

2. Complete the information in each section of the Template Add box and click Save.
See Template Field Definitions for detailed descriptions of the field-level options in this

template.
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Template Field Definitions

1 | Information

Name Descriptive name to identify the template.

Description
(Optional)

Description of template.

Access Group Name of the user who can run/view this template
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2 | Cube View and Scenario

Cube Name of the Cube to run models against for the template.

Cube View Name of the specific Cube View in the Cube to run the models against

for this template.

See Also: Cube View Setup

NOTE: The Cube View can only pull data from the Cube that was specified above.

Pulling data frommultiple Cubes for a single Cube View is not allowed in Predictive

Analytics 123.

Source
Scenario

Scenario specified as the source of historical data points used to generate

predictive models.

Target
Scenario

Scenario to write the results of the model execution.

IMPORTANT: The Source Scenario and Target Scenario must have the same
writable cells.

3 | Time Range
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Reference
Period

The period used to identify the last period to be included in the historical

dataset for models run on the specified account.

Required for Run and Run All.

The reference period used should also be included in the Cube View to be

visible on the Predict page.

Historical
Range

The number of data points to use to fit the models.

Example: If the selected cell for the account is 2019M11, and Historical

Range is 24, the historical datapoints to be used for fitting the models will

be all the values from 2017M11 to 2019M11.

IMPORTANT: Aminimum of 18 months of data is necessary to return valid

prediction models. For predictive models, particularly seasonality, twenty-four

months of historical data are necessary (ARIMAmodels require 48 months). Rows

missing the required number of historical months will be excluded from the

prediction.

Forecast
Range

The number of datapoints to run against, going forward from the selected

cell.
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Prediction
Write Start
Period

The number of periods forward from the selected cell period to begin

writing forecasts. The template defaults to a write start of 1, which

corresponds to the period directly after the selected cell period.

Example: If the selected cell in the account is for 2005M11, and the

Prediction Write Start Period is 5 with a Forecast Range of 12 months, 12

forecast values would be written beginning at 2006M4 through 2007M3.

4 | Model

Default Model Determines the models to run for the template.

Auto-Seasonality Models performs a grid search of all Seasonality
specific models with all possible parameter subsets.

This method will return the best performing Seasonality specific models

for the account in the template.

Auto-All Models performs a grid search of all models with all possible
parameter sub-sets.

This method will return the best performing models for the account in the

template.

Auto-Trend Models performs a grid search of all Trend specific models
with all possible parameter sub-sets.

This method will return the best performing Trend specific models for the

account in the template.
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If a specific model type is selected in this section, a grid search of that

specific model’s parameter sub-sets will be performed.

This method will return the best performing parameter subset model of

the specified model type.

Seasonality
Length

Sets the seasonality length for the data that the models will use as the

seasonal cycle. This value can be specified by the user or Auto-Detect

can be specified in which case the algorithm itself will determine the best

seasonality length for the data.

Failure
Resolution

Determines the models to run in the event the default model returns a

Failure response.

Save Default
Model

Saves the selection in Default Model.

5 | Run All

Allow Run All
Accounts

Runs every account in the Cube View and determines the best model for

each account according to the specifications set in the template editor.

Account Filter
(Optional)

Follows the standard OneStreammember filter, an admin can filter the

Cube View accounts using the standard formulas present in the Member

Filter Builder .
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NOTE: It is advised not to edit and run templates in two separate tabs/sessions
because the newest information will not update. If using Predictive Analytics in this

way, always click refresh before running the model. If multiple users are working

collaboratively on different machines, lasting changes can only be made by the

user who most recently called for a run

Cube View Setup Notes
l Predictive Analytics 123 will only write prediction model results for Base level accounts.

l For Predictive Analytics 123 to write prediction model results to forecasted cells in a Cube

View, set Can Modify Data to True.

l Users must be in the Access andMaintenance security groups of the Cube View where

predictive models will be run.

IMPORTANT: Data must be controlled using Cube View settings or it will be

overwritten by prediction model results.

Assign Cube View Bound Parameters

Bound Parameters are required to apply predictive models to a Cube View. To assign Bound

Parameters in OneStream, click Application > Cube Views >General Settings > Navigation
Links.

TIP: Set parameters once in a Cube View and then use the Copy button on the
Cube View page to create a new one from a template.
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Bound Parameter Name Value

Entity E_PAMME
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Bound Parameter Name Value

Consolidation Not used

Scenario S_PAMME

Time T_PAMME

View V_PAMME

Account A_PAMME

Flow F_PAMME

Origin O_PAMME

IC I_PAMME

UD1 U1_PAMME

UD2 U2_PAMME

UD3 U3_PAMME

UD4 U4_PAMME

UD5 U5_PAMME
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Bound Parameter Name Value

UD6 U6_PAMME

UD7 U7_PAMME

UD8 U8_PAMME

NOTE: Predictive Analytics writes data prediction results to O#Import and not
O#Forms no matter what is specified in the Cube View.

Apply Predictive Analytics 123 to Forms
There are two end user Dashboards in the XFW Predictive Analytics 123 (PAM) Dashboard
Group:

1. ListViewer_PAMV

2. SingleViewer_Template_PAMV
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Set Up List View

The List View dashboard contains the information from the Predictive Analytics 123 Predict page

including the Template Selection list. This dashboard can be embedded into a workspace inside a

workflow.

1. In OneStream, click Application > Presentation > Dashboards.

2. Click Dashboard Maintenance Units > XFW Predictive Analytics 123 (PAM) >
Dashboard Groups >End User Viewers (PAMV) > ListViewer_PAMV.

3. (Optional) On the ListViewer_PAMV dashboard, click Rename to rename the dashboard.

4. Click Save.

5. Click Run to verify that the dashboard opens correctly.
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Setup Single View

The Single View dashboard contains the information from the Predictive Analytics 123 Predict
page excluding the Template Selection form.
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1. In OneStream, click Application > Presentation > Dashboards.

2. Click Dashboard Maintenance Units > XFW Predictive Analytics 123 (PAM) >
Dashboard Groups > End User Viewers (PAMV).

3. Select SingleViewer_Template_PAMV and click Copy on the top toolbar.

4. Click the Paste on the top toolbar.
A new dashboard called SingleViewer_Template_PAMV_Copy displays.

5. Select the SingleViewer_Template_PAMV_Copy and click Rename in the top toolbar.

TIP: Replace the word "Template" in the name for the name of the Predictive
Analytics 123 template that will be embedded into this single view. Remove all

spaces in the template name.

6. Click Save and navigate to the new dashboard.

7. In the Dashboard Properties pane, expand Action (Primary Dashboard Only).
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8. Type the exact name of the template to embed in the dashboard in the Load Dashboard

Server Task Arguments field.

9. Click Save.

10. Click Run to verify that the template name was correctly specified.
This newly created Template Dashboard can now be embedded into a workspace inside a

workflow.

11. Click Save.
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Predict
The Predict page displays the interactive mode that runs the models against a selected cell or
all accounts in a Cube View. Results are graphically displayed and written back to either a

Cube View or a different target scenario.

Run Prediction Models
IMPORTANT: Consolidate must be set to #Local or Predictive Analytics 123 does
not store predicted data. Within the POV Pane, ensure that Consolidate is set to

#Local under the Cube POV.

Predictive Analytics runs predictions sequentially, meaning if a client wants to run predictions on

multiple data sets or entities, the system will have to finish one template first before going to the

next one.

NOTE: Predictive Analytics will run one template at a time. If a second user clicks
Run while the first user's prediction is still running, the second user will get an error

message. The first user's prediction must complete before the second user can

click Run.
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Users can utilize the Task Activity button in OneStream that shows a backlog of all events in the

application. This is especially helpful when utilizing the Run All function, as the Task Activity will
show that ExecuteRunAll_PAM is running, with a duration of the activity next to it. When

completed, a banner that says 1 background task completely successfully will pop up
underneath the Task Activity button. If another Run All is started, a pop-up box will read Run All
Already Running.
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To run the model with respect to the selected cell:

1. In the Template Selection panel, select a template.

NOTE: Templates could be restricted based on the current user’s access level and
the Access Group associated with the template in the template definition step.

2. Click on the cell in the account to run models for.

You can only run against cells that are within the reference period as defined in the setup.

3. Click Run.
If the cell for that account already has models run on the selected template, the lower panes

will be pre-populated.

NOTE: The Run button is hidden until a historical cell is selected but Run All is
always visible.

For a growth rate to be displayed as a non-NAN value, the forecast period must be equal to or

longer than the total number of historical values.

After the models are run against the selected cell, a graph of the results and the Prediction growth

rate display in the lower pane:
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Run: This button will be hidden until a cell is selected. Select this button to run a model against a
specific account.

Run All: determines the best model for each account according to the specifications set in the
template editor. After using this function, each account will be pre-populated with a model.

Selected Period: The time that the model corresponds to.

Account: The account dimension member name.

Reference Period: Used to identify the last period of the historical dataset used in the forecasting
of the model.

Forecast Range: Determines how far into the future the model runs through, going forward from

the selected cell.

Prediction Growth Rate: Percent change of the target variable throughout the forecast range.

Default Model: Determines the model type being run for the selected template and produces the
displayed growth rate.

The Clear button removes the saved default model from each line on the template but keeps the

graphical results and details of previously run models. When it is rerun, it will once again choose

the most optimal model. This can be helpful when there is an update to the historical data. As

shown below, the default model section of the graph is the only element cleared.
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The Delete button removes the graphical results, details, and comments of the model but does
not delete the template. As shown below, the Delete button is used to clear out the model forecast
that has been run. Using this button does not delete any of the historical data, so the model can be

rerun as soon as it is deleted. This can be helpful if there is an update in the historical data that

would result in the possibility of new results.

Predictive Analytics 123 Guide xxxix

Table of Contents



TheModel button brings the user back to the page with growth rate, seasonality, and graphical
results that contains the prediction and actual forecast rates.

The Detail button populates and displays the top prediction models with their corresponding
growth rates on a scrollable pane (only scrollable if multiple models are returned). To the right of

this, the Mean Absolute Percent Error and Mean Percent Error are displayed on dials to show

model accuracy. The right pane of the graph displays the selected model, and the error gauges

and graphs change when a different model is selected.
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The Show Report Function produces a printable table of the projected forecast.
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NOTE: The Predict page has a scrollable pane on the left-hand side under the
Template Selection that allows the user to see the build of the template. Once

expanded, the pane shows the base information needed for the source of the

model, the target scenario, and the default model it will use when.
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Model Comments

The Comments button opens a new dialog box that allows the user to add/save a comment that

stays with the model run for that specific line. The dialog box will display the comment, the user,

and the time stamp.

NOTE: If there is already a comment for that model, there will be a pre-populated
table in this section and the icon will change to a comment bubble with three dots

inside. If there are no comments, the table will not be pre-populated.

Functions of Model Comments:

Predictive Analytics 123 Guide xliii

Table of Contents



l When a comment is made on a line item, it will remain on that line for the life of the template.

l Comments can be left individually for each line item, but they cannot be made on the

template itself.

l In the Audit section, once the correct template is selected, the comments will populate for

each line within the template.

o As shown below, two comments were made on different days and for different lines

within the template, but both will show for that template in the Audit section.

l In the top drop-down bar, the user can choose if they want to see comments for

everyone/all templates or a specific individual/one template.

IMPORTANT: There is no way to delete a comment once it has been made.
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NOTE: Comments are associated with the account of the Cube View and the

currently selected template.

Forecasting Methods
This appendix describes the supported forecasting methods.

Simple Exponential Smoothing

This forecasting method develops a model where the prediction is a weighted linear sum of recent

past observations. Exponential Smoothing models explicitly use an exponentially decreasing

weight when considering past observations. Single Exponential Smoothing only requires one

parameter alpha, also called the smoothing factor or smoothing coefficient. Alpha controls the rate

of influence of the observations at each prior timestep. The parameter is handled inside the

algorithm and thus is unspecified by a user.

NOTE: Simple Exponential Smoothing Models are best at handling data with no
clear trend or seasonal components.
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Holt Linear
This forecasting method is an extension of Simple Exponential Smoothing (See Simple

Exponential Smoothing) that adds the ability to capture the trend of the time series. This method is

commonly referred to as Double Exponential Smoothing because it uses an additional smoothing

factor beta to handle the influence of the overall trend. The method is broken into two variations,

Additive and Multiplicative.

NOTE: Holt-Linear Models are capable of handling data with a trend component
but not seasonal components.

Holt-Linear Additive

In this variation, the smoothing factor beta is expressed in absolute terms in the scale of the

observed series. The additive method is preferred when the seasonal variations are changing

proportionally to the level of the series.

Holt-Linear Multiplicative

In this variation, the smoothing factor beta is expressed in relative terms or as a percentage. The

multiplicative method is preferred when the seasonal variations are changing disproportionally to

the level of the series.
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Holt-Winters Exponential
This forecasting method is an extension of Double Exponential Smoothing (see Holt Linear) that

adds the ability to capture the seasonality of the time series data. This method is referred to as

Triple Exponential Smoothing. In addition to the alpha and beta parameters found in Double

Exponential Smoothing, there is an added smoothing seasonal parameter gamma used to handle

the influence of the overall seasonality. The method is broken into two variations based on the

handling of the parameter gamma:

Seasonal Additive

The seasonal additive model is an extension of the Holt-Winters Exponential Additive Model. The

Seasonal Additive model does not contain a trend equation, or parameter beta, and instead only

applies the seasonal parameter gamma using the additive method.

NOTE: The Seasonal Additive model is only capable of handling data with a
Seasonal component but no Trend Component.

Holt-Winters Exponential Multiplicative

In this variation, the seasonal parameter gamma is expressed in relative terms or as a

percentage. The trend equation of the series is seasonally adjusted by dividing each value by the

seasonal parameter gamma. The multiplicative method is preferred when the seasonal variations

are changing disproportionally to the level of the series.
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Holt-Winters Damped Method

The damped method is used for long-term forecasts and is and extension of the Holt-Winters

Exponential (Additive and Multiplicative). For long-term forecasts, a Holts-Winters Exponential

model will increase or decrease indefinitely into the future. With the addition of a damping

parameter between zero and one, this long-term increase or decrease can be minimized, and

accurate long-term predictions can be maintained. The damping parameter is handled inside the

algorithm and is unspecified by a user.

NOTE: Holt-Winters Exponential Models are capable of handling data with trend

and seasonal components.

Seasonal Multiplicative

The seasonal multiplicative model is an extension of the Holt-Winters Exponential Multiplicative

Model. The Seasonal Multiplicative model removes trend equation, or parameter beta, and

instead only applies the seasonal parameter gamma, using the multiplicative method.

NOTE: The Seasonal Multiplicative model is only capable of handling data with a
Seasonal component but no Trend Component.
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Autoregressive Integrated Moving Average
(ARIMA)
The Autoregressive Integrated Moving Average model is a non-seasonal time series method that

combines three techniques when producing predictions. The first, corresponding to the “AR”,

indicates the autoregressive component. This component regresses the desired variable over its

previous values. The order of this portion of the model is specified by the parameter P. The

second, corresponding to the “MA”, indicates the moving average component and is a regression

of the desired variable’s errors over its previous values. The order of this portion of the model is

specified by the parameter Q. The third, corresponding to the “I”, indicates the integrated or

differencing component and is a differencing of each value and its previous value. The order of

this portion (number of times to perform differencing) is denoted by the parameter D. The

differencing “I” component is performed before the “AR” and “MA” components are fit. The overall

ARIMA is the combination of each of these three components into one condensed model.

NOTE: The ARIMAmodel is only capable of handling data with a trend component

but no seasonal component.
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Seasonal Autoregressive Integrated Moving Average
(SARIMA)

The SARIMAmodel is a seasonal time series method and an extension of the ARIMAmodelling

method. It contains the same three components of the ARIMA, however, a SARIMA adds an

additional seasonal autoregressive, seasonal differencing, and seasonal moving-average

component to the overall model to account for the recurring cycle of the data. The parameters for

each of these additional seasonal components are denoted by P, D, andQrespectively. The

SARIMA also takes in a seasonal parameter which accounts for the length of a singular cycle in

the data.

Graph Details
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The Title will display the model type that is run for the account.

The Axes will always be labeled as Quantity and Time. The Quantity axis will scale to the given
line item. The Time axis will do the same in a year-month format. For example, 2022M3

references March of 2022.

The Legend on the right-hand side of the graph displays the three line types shown. Actuals

refers to the historical data that was selected in the model template. Model Fit shows the line of

best fit for the historical data. Prediction Result is the official forecast produced by the model.

NOTE: The gap between the Model Fit/Actuals lines and the Prediction Results is
not actually a gap in the dataset. The Actuals ends in one month and the Prediction

starts in the next month, so there is no data in between as the data is set at a

monthly level of time detail or granularity.
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Audit 
The Audit page is three sections of report-style data that displays information such as the
number of models run per account, the types of models, who ran each model, which model was

run, the target scenario, and the creation date of the model run. This information is summarized

on theOverview tab with detail in the Analysis tab.

The Analysis tab contains the following information:

l Commentary provides all commentary by Account and Cube View.

l Model Executions provides all single account model executions by Cube View.

l Run All Statistics provides statistics of all Run-All account model executions by Cube View.
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Help & Miscellaneous Information

This page contains solution documentation.

Specify Optimal Display Settings
To best display multiple data elements such as reports and forms for data entry and analysis, set

your screen resolution to a minimum of 1920 x 1080.

Package Contents & Naming Conventions
The package filename contains multiple identifiers that correspond with the Platform. Renaming

any of the elements contained in a Package is discouraged to preserve the integrity of the naming

conventions.

Example package name: PAM_PV6.2.0_SV103_PackageContents.zip

Identifier Description

PAM Solution ID

PV620 Minimum Platform version required to run solution

SV103 Solution version number

PackageContents Filename
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OneStream Solution Modification
Considerations
A few cautions and considerations regarding the modification of OneStream Solutions:

l Major changes to business rules or custom tables within a OneStream Solution will not be

supported through normal channels as the resulting solution is significantly different from

the core solution.

l If changes are made to any dashboard object or business rule, consider renaming it or

copying it to a new object first. This is important because if there is an upgrade to the

OneStream Solution in the future and the customer applies the upgrade, this will overlay

and wipe out the changes. This also applies when updating any of the standard reports and

dashboards.

l If modifications are made to a OneStream Solution, upgrading to later versions will be more

complex depending on the degree of customization. Simple changes such as changing a

logo or colors on a dashboard do not impact upgrades significantly. Making changes to the

custom database tables and business rules, which should be avoided, will make an

upgrade even more complicated.
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Appendix A: Target Scenarios
To get accurate predictions, the accounts need to have at least twenty-four months of historical

data. Historical data should be set up in dense cube views. Sparse data is not recommended as

Predictive Analytics cannot use sparse data to make time series statistical predictions.

This solution is meant to be used interactively and not in batch mode. Predictive Analytics can

only run one template at a time and cannot run multiple templates at once in a batch. There is no

built-in functionality to automate running templates for Predictive Analytics.

NOTE: It is recommended that users not exceed 300 targets in a Predictive
Analytics template, as going beyond this value will result in long prediction run

times.

Predictive Analytics 123 can be used in situations where there is anywhere from one target to up

to three-hundred targets. Some examples of use cases are listed below:

l One Sales account by one Entity by one UD1 member by one UD2 member across twenty-

four time periods is one target.

l One Sales account by five Entities by one UD1 member by one UD2 member across

twenty-four time periods is five targets (five Entities)

l One Sales account by five Entities by five UD1 members by one UD2 member across

twenty-four time periods is twenty-five targets (five Entities * five UD1 members)
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l One Sales account by five Entities by five UD1 members by five UD2 members across

twenty-four time periods is 125 targets (five Entities * five UD1 members * five UD2

Members)

An example use case is written and shown below:

l One Sales account by five UD2 members by three UD4 members across 12 time periods is

15 targets (5 UD2 members *3 UD4 members)

In this scenario, Operating Sales is the account, the type of ball is the UD2 member, and the store

is the UD4 member. The final row is the column total and is not included in the target number.

NOTE: If your use case calls for making automated predictions or utilizing larger
volumes of data (greater than 300 targets), it is suggested that you consider

Sensible Machine Learning for your predictive analytic use cases. Sensible

Machine Learning has the ability to handle a larger amount of targets along with a

number of other features.
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NOTE: The example shown is from one of the GolfStream applications. Your

results will differ depending on your historical results and the configuration of your

prediction template.
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Appendix B: Use Case Example
A company wants to predict monthly golf ball sales for the next 12 months from five different lines

(Tour, Premium, Range, Logo, and Logo tour) in three different stores (Dick's Sporting Goods,

Dunham's, and Walmart). Twenty-seven months (January 2020 to March 2022) of historical

monthly data points with no additional variables will be used in the prediction with a forecast

length of 12 months.

Template Field Inputs
Cube View and Scenario: To predict the monthly revenue of gold balls, the Cube of Profitability
and Cube View of PAM Projection Golf Balls Revenue must be selected.

l The Source Scenario will stem from the data spanning twenty-seven months with a Target
Scenario of producing a predictive model.

Time Range:

l The Reference Period refers to the last month of historical data that should be included in
the model (in this case March of 2022) and displays in the first column on the Predict page.

l The Historical Data refers to the number of months prior to the reference period that will be
used to train the model. In this case, with only twenty-seven months of historical data, all

the data is useful and will stem back to January 2022.

Predictive Analytics 123 Guide lviii

Table of Contents



l A Forecast Range of one to sixty months can be selected; however, with only twenty-
seven months of historical data, a forecast of 12 months will be selected since a prediction

set too far in advance can lead to extrapolated data.

l A Prediction Write Start Period of one is selected to set the forecast values for the period

directly after the reference period.

Model:

l The Default Model will be set to Auto-Seasonality Model since golf is more popular in
the summer and the data will have seasonality.

l The Seasonality Length will be set to Auto-Detect since no external factor gives the data
a specific range.

l The Failure Resolution will be set to Auto-Seasonality so that this model will run if there
is a failure response.

l The Default Model should be saved so the results do not need to be rerun each prediction.
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Predict
The Template Selection is a list of all templates created by the user. In this case, 2022M4 Golf
Balls Projection Revenue will be selected to use the created template. Each line item on the table

has its historical data and forecast.

l To get a specific forecast, click on a box in the grayed-out Mar Actual column and click
Run to get the forecast for that location.

l Clicking Run All will make each account forecast for their respective locations.
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l The Growth Rate encapsulates what to expect in the coming 12 months. The model is
projected to perform slightly worse than past years in this instance, so it has a very low

negative growth rate.

l The user should click Details to check the error values from each of the top prediction

models. With a Mean Absolute Percent Error of 7%, the percent value can be interpreted as

the average difference between the forecasted value and the actual value.

There are six models being run in this example, so the user can select which model to display and

use the scrollable bar on the left pane. The selected model on the left will change the growth rate,

each of the error dials, and the graph projection.
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NOTE: The example shown is from one of the GolfStream applications. Your

results will differ depending on your historical results and the configuration of your

prediction template.

Audit
Viewing the Audit Report:

l Click Audit to see the audit report that corresponds to the project.

l Use the Template drop-down menu to select the desired template (in this case 2022M4
Golf Ball Revenue Projection). The table populates with information about each model run

in the specified template.
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l Use the User drop-down menu to select the desired user (In this case All is the preferred
option). The table populates with information about the specified template for that user.

l The Model Breakdown pie chart specifies the number of times each model was run. The
chart can help users refine which model to select if they need one uniform choice across all

locations.

The Analysis Tab:

l The Commentary tab holds the comments from the Predict page for each line item within

the specified template.

l The Model Executions tab is the full version of theOverview tab's lower-left pane.

l The Run All Statistics tab is used to check for any model failures when running a Run All.
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Appendix C: Custom Event Model
The purpose of the Custom Event Model is to provide user customization that remains in place

and is bypassed during a solution upgrade. The Predictive Analytics solution supports these

models using Business Rules.

Set Up the Custom Event Model
1. On the Application tab click Dashboards > Dashboard Maintenance Units > XFW

Predictive Analytics (PAM) > Files

2. In the Files folder, click CustomEventHandler_Pam.zip.
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3. In the General (File) pane, click Download File and save the file to an appropriate
location.

4. On the Application tab, click Tools > Load/Extract.

5. On the Load tab, locate CustomEventHandler_PAM.zip using the Select File icons and
clickOpen.

6. When the solution's file name appears, click Load to import the business rule.

Integrate Business Rules
After importing the business rule, updating the PAM_EventHandler business rule to integrate with

the CustomEvents business rule.

1. In theGeneral section of the PAM_SolutionHelper script Properties tab, add
BR\CustomEvents_[[[[PredictiveAnalytics]]]] to Referenced Assemblies.

2. In theGeneral section of the PAM_EventHandler script Properties tab, add
BR\CustomEvents_[[[[PredictiveAnalytics]]]] to Referenced Assemblies
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3. Comment out line 42 of the PAM_EventHelper business rule.

4. Uncomment line 43 of the PAM_EventHelper business rule.

Once the custom event integration is set up, event actions can be defined in the

CustomEvents_[[[[PredictiveAnalytics]]]] script.

IMPORTANT: These events will not be deleted or overridden when upgrading
to new versions of Predictive Analytics. However, each time a new version is

upgraded, apply these setup steps.

Available Custom Events

Before/After Selection Changed Events

These events run before/after a custom control is clicked.
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l SaveSettings

l CreateSolutionTables

l ValidateSetupStepsExecuted

l Uninstall

l OnTableEditorOrGridSelection

l OnComboBoxSelection

l OnButtonClick

l OnShowContentPage

Before/After Save Data Events

These events run before/after the save event for a table editor. For example, this can be used to

test grid data prior to saving and potentially not allowing data to be saved if a check fails.

l OnSaveOrUpdateTableEditor
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Appendix D: Trend and
Seasonality Definitions
A Trend is a general systematic linear or nonlinear component that changes over time and does
not repeat. The following graph shows the result of the Holt Exponential method applied to an

overall trend component.
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The Seasonality or seasonal cycle of a dataset is the number of points that occur in one cycle of
data. Common seasonal cycles include 12 months (yearly) and three months (quarterly).
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Appendix E: Predictive Analytic
Metrics
This appendix describes the predictive analytic metrics you can use to evaluate results.

Metrics

i’th actual datapoint value

i’th predicted datapoint value

total number of datapoints

Mean Percentage Error (MPE)

Mean Percent Error (MPE) shows the average deviation between the actual and predicted values.

This is useful for understanding the magnitude and direction of the errors in relation to the actual

values. The drawback of Mean Percent Error is that the results are more biased when the actual

values are closer to zero.
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Mean Absolute Percentage Error (MAPE)

Mean Absolute Percent Error (MAPE) shows the average absolute deviation between the actual

and predicted values. If large outliers are present, it is best to remove them from the dataset as

they can skew the error. However, Mean Absolute Percent Error is the better option in a dataset

where outliers provide value as it cannot be skewed directionally.
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